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EXCEL CHAPTER 5: SUBTOTALS, PIVOTTABLES AND PIVOTCHARTS
Available Instructor Resources
	Resource
	File Name
	Found

	Student Data Files
	various
	Online Instructor Resource Center

	Solution Files
	various
	Online Instructor Resource Center 

	Answer Keys 
	 
	Online Instructor Resource Center 

	      Matching
	e05_answerkey_match
	

	      Multiple Choice
	e05_answerkey_mc
	 

	      Concepts Checks
	e05_answerkey_concepts
	 

	Scorecards
	e05b1Tips_scorecard

	Online Instructor Resource Center 

	Scoring Rubrics
	e05b1Tips_rubric
	Online Instructor Resource Center 

	Annotated Solution File
	e05b1Tips_annsolution
	Online Instructor Resource Center 

	Scripted Lecture (Script)
	e05_script
	Online Instructor Resource Center 

	    Scripted Lecture Solution
	e05_script_solution
	

	    Scripted Lecture Data
	e05_script_data
	 

	PowerPoint Presentation
	e05_powerpoints
	Online Instructor Resource Center 

	Testbank
	e05_testbank
	Online Instructor Resource Center 

	Instructor's Manual (lesson plans incl.)
	e05_instructormanual
	Online Instructor Resource Center 

	Assignment Sheet
	e05_assignsheet
	Online Instructor Resource Center 

	Prepared Exam (Chapter & App)
	 
	Online Instructor Resource Center 

	      Prepared Exam-Chap instruction
	e05_exam_chap_instruction
	

	      Prepared Exam-Chap solution
	e05_exam_chap_solution
	

	      Prepared Exam-Chap Data
	e05_exam_chap_data
	

	      Prepared Exam-Chap Annotated Sol.
	e05_exam_chap_annsolution
	

	      Prepared Exam-Chap Scorecard
	e05_exam_chap_scorecard
	

	      Prepared Exam-App instruction
	e05_cumexam_instruction
	 

	      Prepared Exam-App solution
	e05_cumexam_solution
	 

	      Prepared Exam-App Data
	e05_cumexam_data
	 

	      Prepared Exam-App Annotated Sol.
	e05_cumexam_annsolution
	 

	      Prepared Exam-App scorecard
	e05_cumexam_scorecard
	 

	File Guide
	e05_file_guide
	Online Instructor Resource Center 

	Instructor Resource Card
	e05_ircard
	Online Instructor Resource Center 

	Objective Map
	e05_objectivesmap
	Online Instructor Resource Center 

	Online Chapter Review
	e05_chapt_checklist
	Companion Website for Students

	Grader Project
	 
	 

	       Grader-instruction
	e05_grader_instruction
	Online Instructor Resource Center 

	       Grader-solution
	e05_grader_solution
	

	       Grader-data
	e05_grader_data
	

	       Grader-annoted. Solution
	e05_grader_annsolution
	 

	       Grader-scorecard
	e05_grader_scorecard
	 

	Additional Projects (Practice & Mid Level)
	 
	Online Instructor Resource Center 

	       Additional Proj-Practice instruction
	e05_p_addproject_instruction
	

	       Additional Proj- Practice solutions
	e05_p_addproject_solution
	

	       Additional Proj-Practice Data
	e05_p_addproject_data
	

	       Additional Proj-Practice Ann Sol.
	e05_p_addproject_annsolution
	

	       Additional Proj-Practice Scorecard
	e05_p_addproject_scorecard
	

	       Additional Proj-Mid Level instruction
	e05_ml_addproject_instruction
	 

	       Additional Proj-Mid Level solutions
	e05_ml_addproject_solution
	

	       Additional Proj-Mid Level Data
	e05_ml_addproject_data
	

	       Additional Proj-Mid Level Ann Sol.
	e05_ml_addproject_annsolution
	 

	       Additional Proj-Mid Level Scorecard
	e05_ml_addproject_scorecard
	 



CHAPTER OBJECTIVES 
When students have finished reading this chapter, they will be able to:

· Subtotal data
· Group and ungroup data
· Create a PivotTable
· Modify a PivotTable
· Filter and slice a PivotTable
· Create a calculated field
· Format a PivotTable
· Use PowerPivot functionality
· Create a PivotChart



CHAPTER OVERVIEW
The major sections in this chapter are:
Subtotals and Outlines: Subtotaling data; grouping and ungrouping data 
PivotTable Basics: Creating a PivotTable; modifying a PivotTable
PivotTable Options: Filtering and slicing a PivotTable; creating a calculated field
PivotTable Design and PivotCharts: Formatting a PivotTable; using PowerPivot functionality; creating a PivotChart 
CLASS RUNDOWN
1. Have students turn in homework assignments.
2. Talk about chapter using discussion questions listed below. 
3. Use PowerPoint presentation to help students understand chapter content.
4. Demonstrate using Excel 2013 for tools in this chapter.
5. Run through Scripted Lectures for chapter.
6. Have students complete Capstone Exercise for Excel Chapter 5.
7. Use MyITLab for in-class work or to go over homework.
8. Give students Homework Handout for next class period. 

LEARNING OBJECTIVES
At the end of this lesson students should be able to:
· Subtotal the data
· Add a second subtotal
· Collapse and expand the subtotals
· Group and ungroup data
· Create a PivotTable
· Add rows, values, and columns
· Remove and rearrange fields
· Change the values field settings
· Refresh a PivotTable
· Set filters
· Insert and customize a slicer
· Create a calculated field
· Show values as calculations
· Apply a PivotTable style
· Create a PivotChart

KEY TERMS
Calculated field – A user-defined field that performs an arithmetic calculation based on other fields in a PivotTable.
Columns area – The region in which to place a field that will display labels to organize data vertically in a PivotTable. 

Data mining – The process of analyzing large volumes of data to identify patterns and trends. 

Filters area – The region in which to place a field so that the user can then filter the data by that field in a PivotTable or PivotChart. 
Grouping – (1) The process of joining rows or columns of related data into a single entity so that groups can be collapsed or expanded for data analysis. (2) The process of selecting worksheets to perform the same action at the same time. 
Outline – A hierarchal structure of data organized so that groups can be expanded to show details or collapsed to show high-level structure. 
PivotChart – A graphical representation of data in a PivotTable.
PivotTable – An interactive organization of data that consolidates and aggregates data by categories that can be sorted, filtered, and calculated. 
PivotTable Fields task pane – A window that enables a user to specify what fields are used from a dataset and how to organize the data in columns, rows, values, and filters. 
PowerPivot – A PivotTable functionality in which two or more related tables can be used to extract data into a PivotTable.
Relationship – A connection between two or more tables using a common field, such as an ID field.
Rows area – The region in which to place a field that will display labels to organize data horizontally in a PivotTable.
Slicer – A window listing all items in a field so that the user can click a button to filter data by that particular item or value.
Slicer caption – The text or field name that appears as a header or title at the top of a slicer to identify the data in that field.
Subtotal – An aggregate calculation, such as SUM or AVERAGE, that applies to a subcategory of related data within a larger dataset. 
SUBTOTAL function – A math or trig function that calculates the total of values contained in two or more cells.
Values area – The region in which to place a field that will display aggregates, such as SUM, for categories of data in a PivotTable.
DISCUSSION QUESTIONS
· How would you explain PivotTables to someone who has never used them before?
· Can data mining be used maliciously? How and why?
· Are PivotTables exclusive to Excel?
· Why is a good understanding of basic math concepts—or even more advanced ones—helpful to using Excel?
WHEN USING SCRIPTED LECTURE IN CLASS, DEMONSTRATE HOW TO:
· Subtotal the data
· Add a second subtotal
· Collapse and expand the subtotals
· Group and ungroup data
· Create a PivotTable
· Add rows, values, and columns
· Remove and rearrange fields
· Change the values field settings
· Refresh a PivotTable
· Set filters
· Insert and customize a slicer
· Create a calculated field
· Show values as calculations
· Apply a PivotTable style
· Create a PivotChart

CONNECTIONS PRACTICAL PROJECTS AND APPLICATIONS
· Have students speculate on how they would use PivotTables in their own lives. If possible, have them use accessible data and create PivotTables for use in their own organizations. If you don’t have real data for them to use, you can obtain sample data from the PivotTable report template and instructions in Google Docs. 
· Have students write reports to their “supervisors” on how and why they could use PivotTables on the job.

TEACHING NOTES

Subtotals and Outlines 
Using large datasets develops an appreciation for functionality that enables the management of data and the ability to quickly provide answers to imperative questions. 
A. Subtotaling Data
· Teaching Tip: The subtotal rows are temporary. To remove them, display the Subtotals dialog box and click Remove All. 
· After collapsing the outline to view just the subtotals, you might want to copy them. This can be messy, however, and have unexpected results. You will need to use Go To Special to select only the visible cells before copying. 
· Make sure you sort FIRST before subtotaling data. This is a common mistake. 
· You can add subtotals that use the same function to more than one column at the same time—this can help students use this feature more efficiently. 
· Remind students that they cannot use the Subtotal feature with Excel tables or with lists. You may want to spend some time showing students the difference between a table, a list, and a data range. 
B. Grouping and Ungrouping Data
· Teaching Tip: To remove groups, select all grouped columns or rows and click Ungroup in the Outline group. 
· Teaching Tip: Remind students they need to subtotal by the primary category first and then subtotal by the secondary category. 
· Emphasize that using consistent values will return the correct results—each group’s value must be the same across all records. 
· Ctrl+8 will temporarily hide (or unhide) the pane with the viewing levels that Excel displays to the left when the Subtotal feature is active. 
PivotTable Basics 
Analyzing large amounts of data is important for making solid decisions. 
A. Creating a PivotTable
· Teaching Tip: At first glance, PivotTables are similar to subtotals because they both produce subtotals, but PivotTables are more robust. PivotTables provide more flexibility than subtotals provide. If you need complex subtotals cross-referenced by two or more categories with filtering and other specifications, create a PivotTable. 
· Teaching Tip: If the PivotTable Field task pane does not appear when you click inside a PivotTable, click the Show arrow on the Analyze tab, and then click Field List. This command is a toggle, so you can click it to show or hide task pane. 
· If your students have used PivotTables in Excel 2010, there are some changes in Excel 2013. If you have students who are “upgrading,” spend some time showing them the differences—generally, the newer version is easier to use. 
B. Modifying a PivotTable
· Teaching Tip: You can collapse all categories at one time by clicking Collapse Field in the Active Field group on the Analyze tab. To expand all categories at one time, click Expand Field. This approach is faster than collapsing or expanding each category individually. 
· You can manually create a PivotTable if the ones that Excel suggests do not fit what you need. By default, Excel builds it in a new worksheet in the existing workbook. 
· Teaching Tip: You can display more than one function for a field. For example, you might want to show both the total book sales and the average book sales. To display multiple summary statistics, drag another copy of the same field to the VALUES area and set each value setting separately.
· Teaching Tip: It may be confusing to see Sum of Total… in the VALUES box. Position the pointer over a field name in the area to see a ScreenTip with the full name, such as Sum of Total Book Sales.
· Teaching Tip: To ensure that formulas update automatically, click the File tab, click Options, click Formulas, click Automatic as the Workbook Calculation setting, and then click OK.
PivotTable Options

PivotTables consolidate and aggregate large amounts of data to facilitate data analysis; customization allows more in-depth analysis. 
A. Filtering and Slicing a PivotTable
· You can easily modify PivotTable fields from the original data source display. Display the Field List, then you can remove a field, move a field, or add a field. 
B. Creating a Calculated Field
· Teaching Tip: Click in the PivotTable to display the PivotTable Field task pane if necessary. 
· Power View is an add-in that comes with most versions of Excel 2013, and works with PowerPivot to create visual reports. 
PivotTable Design and PivotCharts 

The overall appearance and format of a PivotTable can help communicate the information it contains.
 
A. Formatting a PivotTable
· PowerPivot was an “add-in” introduced with Excel 2010, but is now integrated into Excel 2013. It still must be activated to be used. You may have to have administrator permission on your computer to do so. 
· The Excel PowerPivot add-in is available in the Professional Plus edition, as well as all editions of Office 365—except for Small Business. It is NOT supported in Excel 2013 running on the RT version of the MS Surface tablet—users need the Surface tablet with Windows 8 Pro to use the PowerPivot add-in. 
B. Using PowerPivot Functionality
· Teaching Tip: Look up the topic What’s new in PowerPivot in Excel 2013 to learn more about the PowerPivot functionality and how to create PivotTables from related tables. The Help menu also informs you which versions of Microsoft Office 2013 contain this feature and how you can enable it. 
C. Creating a PivotChart
· Click the Analyze tab under the PivotChart Tools contextual tab to display the Analyze tools on the Ribbon. 
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ONLINE CHAPTER REVIEW
To find an online chapter review to help your students practice for tests, visit the Companion Website at http://www.pearsonhighered.com/exploring/.
ADDITIONAL WEB RESOURCES
1. What's new in Excel 2013 — http://office.microsoft.com/en-us/excel-help/what-s-new-in-excel-2013-HA102809308.aspx
2. Online Excel Help – www.mrexcel.com  
3. Microsoft Tech Support – http://support.microsoft.com    

PROJECTS AND EXERCISES
	
	Data file
	Save As

	Hands-On Exercise 1
	e05h1Sociology.xlsx
	e05h1Sociology_LastFirst.xlsx

	Hands-On Exercise 2
	e05h1Sociology_LastFirst.xlsx
	e05h2Sociology_LastFirst.xlsx

	Hands-On Exercise 3
	e05h2Sociology_LastFirst.xlsx
	e05h3Sociology_LastFirst.xlsx

	Hands-On Exercise 4
	e05h3Sociology_LastFirst.xlsx
	e05h4Sociology_LastFirst.xlsx

	Practice Exercise 1
	e05p1MensStore.xlsx
	e05p1MensStore_LastFirst.xlsx

	Practice Exercise 2
	e05p2Dinner.xlsx
	e05p2Dinner_LastFirst.xlsx

	Practice Exercise 3
	e05p3Revenue.xlsx
	e05p3Revenue_LastFirst.xlsx

	Mid-Level Exercise 1
	e05m1RealEstate.xlsx
	e05m1RealEstate_LastFirst.xlsx

	Mid-Level Exercise 2
	e05m2Fiesta.xlsx
	e05m2Fiesta_LastFirst.xlsx

	Mid-Level Exercise 3 (Collaboration)
	
	e05m3Facebook_LastFirst.xlsx

	BYC 2 Research 
	
	e05b2OKC_LastFirst.xlsx

	BYC 3 Disaster Recovery 
	e05b3Games.xlsx
	e05b3Games_LastFirst.xlsx

	BYC 4 Collaboration 
	
	e05b4JobFair_LastFirst.xlsx

	Capstone
	e05c1FineArt.xlsx
	e05c1FineArt_LastFirst.xlsx


CHAPTER REVIEW/ANSWERS TO END OF CHAPTER MATERIAL

Key Terms Matching Answer Key

1. 	 A Relationship (K) is an association created between two tables where both tables contain a matching field.
2. 	An Outline (F) is a hierarchical structure of data. 
3. 	A Subtotal (O) is a row within a dataset that displays the total or another statistic for a particular category.
4.	 Grouping (E) is the process of joining related rows or columns of related data. 
5. 	Data mining (C) is the process of analyzing large volumes of data to identify patterns and trends. 
6. 	A PivotTable (H) is an organized structure that summarizes large amounts of data without altering the original dataset. 
7. 	A Calculated field (A) is a user-defined field that performs a calculation based on other fields in a PivotTable.
8. 	A Slicer (M) is a window listing all items in a field and enabling efficient filtering. 
9. 	Drag fields to the Rows area (L) to display categories horizontally in a PivotTable. 
10. 	Drag fields to the Values area (P) to display data as aggregates, such as sums or averages. 
11. 	Drag fields to the Filters area (D) to be able to specify which values or content to include or exclude in the PivotTable. 
12. 	Drag fields to the Columns area (B) to add more vertical data to a PivotTable. 
13. A PivotChart (G) is a graphical representation of aggregated data derived from a PivotTable. 
14. 	The PivotTable Fields task pane (I) is a window that enables you to drag fields to particular areas to build and arrange data in a PivotTable. 
15. 	A Slicer caption (N) is the label that appears at the top of a slicer window. By default, it displays the name of the field used. 
16. 	PowerPivot (J) is a built-in add-in program that enables users to create a PivotTable from multiple related tables.
Multiple Choice Answer Key
1. A worksheet contains data for businesses that are sponsoring this year’s Arts Festival. The worksheet contains these columns in this sequence: Business Name, Address, City, State, and Donation Amount. Data are sorted by State and then by City. What is the default At a change in setting within the Subtotal dialog box, and what would be a more appropriate setting? 
(b) Business Name (default field), State (correct field)
2. You created an outline for a dataset. What does the + button indicate to the left of a row heading?
(d) You can click it to collapse the details of that category. 
3. A worksheet contains a PivotTable placeholder and the PivotTable Fields task pane. Where do you drag the State field if you want a list of each state in the first column of the PivotTable?
(c) ROWS area
4. You just created a slicer for the State field in a PivotTable. Which of the following does not characterize the initial slicer?
(a) The slicer buttons are set to filter out all records.
5. You created a PivotTable and made some changes to values in the original dataset from which the PivotTable was created. How does this affect the PivotTable?
(d) Click Refresh in the Data group on the ANALYZE tab to update the PivotTable.
6. You created a PivotTable to summarize salaries by department. What is the default summary statistic for the salaries in the PivotTable?
(b) Sum
7. What settings should you select for a PivotTable if you want to apply a different color scheme and display different fill colors for main category rows and horizontal lines within the PivotTable?
(c) Banded Rows check box and a different PivotTable style
8. Which PivotTable calculated field is correctly constructed to calculate a 20% tip on a meal at a restaurant?
(b) ='Meal Cost'*.2
9. You have created a PivotChart showing sales by quarter by sales rep. Before presenting it to management, you notice the name of a rep who has since been fired. How do you remove this rep from the chart without deleting the data?
(a) Filter the Sales Rep field in the PivotChart and deselect the employee’s check box.
10. Currently, the House Types field is in the Row Labels area, the Real Estate Agent field is in the Column Labels area, and Sum of List Prices is in the Values area. How can you modify the PivotTable to display the agent names as subcategories within the house types in the first column?
(d) Drag the Real Estate Agent field from the COLUMNS area and drop it below the House Types field in the ROWS area.
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